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Older issues of

Editor

Sydtrug’ newsletters.

For the Sydtrug web site | have long
tried to get hold of older issues of Sydtrug
News, the few | have are packed full of quite
technical information on the TRS80 range of
computers.

Well !l we have been contacted by
lan Mavric down Melbourne way as he has
scanned in his collection of our newsletters
and offered them to the club. Although he is
missing a few copies there is fairly good
coverage from 1983 to 1997.

lan also collects/ repairs TRS80

machines, he will provide a home to any
unwanted TRS80’s complete or otherwise.
He is trying to stimulate interest in the TRS
machines, not so much as a useful
alternative to a current Win7 or MAC
computer, but as collectors and restorers of
old hardware for posterity.

lan repairs, upgrades, purchases
and re-sells TRS stuff... following is the
address of his website to give you more of an
idea of what he does.
ihttp://ianmav.customer netspace.net.au/trs
80/

Initially anyway, | am looking at
putting up a volume at a time from lan’s
collection for a period of a couple of months.
They arein PDF format and can be
downloaded. If you have any of the missing
issues please let us know, perhaps you could
send us a photocopy or scan of the
newsl etter, even send/donate the newsl etter
to us so that we can scan it and complete the
volume. Thisin fact refers to any issues not
on the website.

Astime permits | will be making up
an index not only of recent issues but also
theissues from lan’s collection so that
viewers can locate items they are interested
in.

Thanks for your efforts lan and hope
we can add to your collection.

Note: This month 1986 and 87 have been
added

Choosing a Mouse
By Sandy Berger, CompuKISS Newsletter

sandy (at) compukiss.com

The mouse is a useful computer tool.
Here's a little history combined with
information on the many different types of
mice available today.
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Many people seem to be curious how the
mouse got its name. In the early 1960's, a
man named Douglas Engelbart was
fascinated with a theory he called "human
augmentation technology,” an idea that the
computer should be used to enhance human
performance. Up to that time, computers
were useful only to military and scientific
communities. In 1968, Engelbart made an
input device to help people interact with the
computer. The original mouse was a small
rectangular wooden box with a cable running
to the computer. Since the cord looked like a
tail and mice are known for scurrying along a
surface, this new device quickly became
known as a mouse. The mouse turned out to
be one of Englebart's most ingenious ideas.
Yet, Englebart's original ideas were rejected,
only to be resurrected later by others who
took both the credit and the financial
rewards. Because it frees the user from
having to exclusively use the keyboard, the
mouse is recognized as one of the great
breakthroughs in computing.

The basic functionality and size of the
mouse that we use today has changed little
since 1968, but there have been changes in
the technology behind the mouse. Older mice
worked by a tracking ball on the bottom of
the device. If you are still using this type of
roller ball mouse, it istime for an upgrade.

The newer type of mouse is the
optical mouse. The optical mouse uses a tiny
camera to take thousands of pictures every
second. It employs a light-emitting diode
(LED) that bounces light off the surface on to
a CMOS sensor that is similar to the sensors
used in some digital cameras.

Optical mice have several advantages over
the traditional roller ball mice:

* They have better tracking and a smoother
response.

* There are no moving parts to wear out.

* While dirt gathered inside of the ball and
roller bars of traditional mice interfering with
the tracking, the optical mouse is sealed and
there is no way for dirt to get inside the
mouse.

* They can be used on most surfaces without
a mouse pad. The only exception is a mirror,
glass, or extremely shiny surface.

Most optical mice have a red light
that shines through the bottom of the mouse.
The light can actually be any color. | have
even seen a few that cycle through various
colours, although | don't really see the point
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in that because the bottom of the mouse is
usually not seen.

One of the newest types of mice is the
laser mouse. This is a type of optical mouse
that uses a laser beam instead of an LED
light. The laser beam is invisible, or nearly
invisible, to the human eye. The laser mouse
is more precise and accurate, but also more
expensive. It's great for professional graphic
designers and some gamers might find them
useful, but the average computer user won't
see enough difference to warrant the
increased cost.

So if you are still using a mouse with
aroller ball on the bottom, you might want to
upgrade to an optical mouse. Or buy a new
computer, most of which now come with
optical mice. You will see adifference.

Oh, and when you get to the store, be
prepared to spend a little time in making a
decision. You will find designer mice in red,
green, blue, purple, and other colours. You
will also see mice in many different sizes with
a large variety of finishes. The most
important thing, however, may be for you to
choose a mouse that fits your hand and feels
comfortable.

Also remember that there are other
input devices that can be substituted for a
mouse. There are trackballs, joy sticks, and
touch pads that can be used if you don't find
a mouse comfortable. There are also
specialized devices that can be used for
people with disabilities. Some of these
devices can even adjust for shaky hands and
other dexterity problems. | use a specialized
mouse called an Aerobic Mouse
________________________ is especially
designed for people with arthritis and carpal
tunnel syndrome. It's abig, ugly mouse, but |
love it. It keeps your hand in a hand-shake
position that alleviates the twist in your wrist
that can cause pain if you use the computer
a lot or have carpal tunnel syndrome. It also
steadies the hand, making using the mouse
easier.

So take your time and find the mouse
or input device that is right for you. Today,
most mice attach to your computer through
the USB port. This is a nice feature since it
means that if you and your honey want to
use different mice, they can both be plugged
in at the same time and each person can
have constant access to the mouse of their
choice.
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One-lLiners!!!

The last thing | want to do is hurt you. But
it'sstill on thelist

We livein asociety where pizza gets to your
house before the police.

Should you worry about
retention on an LCD monitor?
By Linda Gonse, Editor/ Webmaster,
ORCOPUG (Orange County PCUG), California

image

editor (at) orcopug.org
July 2011 issue, Nibbles n Bits

| just bought a brand new HP ZR22w
LCD flat screen monitor. My understanding
always has been that burn-in (also called
image retention or image persistence) does
not occur on LCD screens. But, an HP help
file that came with my monitor dispelled that
notion.

“Image retention occurs when the
monitor is left ON while displaying the same
image for an extended period of time, leaving
a ‘shadow’ of this image on the screen.”

| researched the burn-in problem

said “Image retention can be corrected in
most cases and is easily prevented.” That
statement was a relief!

The article went on to list methods
that could be wused to prevent image
retention/persistence.

1. “Set the screen to turn off after a
few minutes of screen idle time under the
Power functions in Windows. Turning the
monitor display off will prevent an image
from being displayed on the screen for
extended periods of time. Of course, this
could be annoying to some people as the
screen may go off more than they wish.”

2. “Use a screen saver that either
rotates, has moving graphic images or is
blank. This also prevents an image for being
displayed in screen for too long.”

3. “Rotate any background images on
the desktop. Background images are one of
the most common causes for image
persistence. By switching backgrounds every
day or few days, it should reduce the change
of persistence.”

4. “Turn off the monitor when the
system is not in use. This will prevent any
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problems where the screen saver or power
function fails to turn off the screen and
result in an image sitting on the screen for
long times.”

The bottom line is not to be too
worried about image burn-in, but keep it in
mind when using your LCD monitor and you
can easily prevent it from happening.

If somehow it does happen, see

to correct existing image retention on LCD
monitors.

Finally, the HP text helpfully revealed
another problem not known to all LCD
monitor users, “the fluorescent lights inside
the display have a limited lifetime and will
gradually degrade.” This is reason enough
not to leave a monitor on 24/7, even with a
screensaver  enabled. Use the timed
Energy/ Power setting to automatically turn
the monitor off when your systemisidlefor a
while.

Three
Camera
By Sharon Walbran, President / Editor, Twin
Cities PC Users’ Group, MN

Gadgets for Your Digital

Walbran(at)yahoo.com
October 2011 issue, The Digital Viking

As an avid photographer with a
couple point-and-shoot digital cameras | am
always on the lookout for gadgets to improve
the experience, but that will not break your
pocketbook. Here are three gadgets under
US$20.00 that solve issues with digital
cameras, and are worth exploring.

Delkin LCD Shade. LCD displays are great
for giving you a preview of the picture you
are about to take and then, after the picture
is taken, showing the picture you took for
review. Unfortunately, in the bright
sunshine, the LCD display is almost
impossible to see. The Delkin Popup LCD
Shade 2.5”, sold through Amazon.com, is a
good solution.

This simple, lightweight plastic shade
attaches to the body of the camera with
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adhesive.

When flipped up the LCD can be read
even in bright sunlight. The side wings fold
in and the shade folds down to neatly cover
the LCD and protect it from scratches and
damage. The side wings are delicate and
could easily break. In the closed position the
shade has a small footprint so there is no
added bulk from this device. The price varies
but can usually be purchased for around
US$10.00.

Quikpod Compod Extendable Handheld
Tripod. If you've ever been on a trip and
wanted to take a photo of yourself and
another person but hesitated to hand your
camera over to a stranger, then this is the
gadget for you. This device is about a foot
long with a diameter of about an inch and
easily fits in a purse or a backpack. On one
end is a screw that attaches securely to the
bottom of your digital camera. Then from

the end nearest you, you can release a
chrome knob that extends the Compod to as
long as 38.5 inches.

I

To take a photo of yourself or yourself
and others, turn on the self-timer on the
camera, strike a pose, and take the shot. The
Compod can also be used to take a photo
over a crowd of people. It has a solid, steady
feel even at a considerable extension. Aiming
the camera in the precise location takes
some practice. The Compod is just one of
several products in this category. One of the
other products is the Quikpod Convertible
Tripod and more accurately called a tripod,
because the rod converts to a 3-legged tripod,
The Compod is available from Amazon.com
for under $20.00.

Joby Gorillapod. Taking photos in low light
demands the use of a tripod because no one
can hold a camera steady enough at such a
low shutter speed. Sometimes finding a flat
surface to place a tripod on is difficult. The
Gorillapod screws into the bottom of the
camera and then, with its flexible spidery
legs, can be twisted to secure the camerato a
fence post or the branch of a tree to hold it
steady.
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The Gorillapod comes in different
sizes to fit compact digital camera and the
heavier SLR Cameras. Higher end and more
expensive models now come with a level
bubble so you can check that the camera is
level when it takes the photo. Of course, the
Gorillapod can be set up as a conventional
tripod as well. It’s lightweight and fits into a
purse or backpack. The Gorillapod is
available from Amazon.com, Target.com,
Adorama.com, and numerous other sellers.
The model for the compact digital camera
usually sells for under $20.00.

These are just a smattering of the gadgets
available. In afuture article I'll review
additional gadgets after I’ve put them
through their paces.

One-lLiners!!!

War does not determine who isright - only
who is left.

Knowledge is knowing atomato is afruit;
Wisdom is not putting it in afruit salad.

The Graphics Side of Word, Part 1

By Nancy DeMarte, Columnist, Office Talk,
Sarasota PCUG, Inc., Florida

ndemarte (at) Verizon.net

May 2011 issue, Sarasota PC Monitor

It is natural to think that a word-
processing program would deal only with
words. Certainly, most commands in
Microsoft Word do relate to editing or
formatting text. But each new version of
Word has introduced more ways to enhance
text with graphical elements like clip art and
photos. This article and the one next month
will deal with the graphics side of Word 2007
-- what the options are and how to use them
within a Word document. Many of these
techniques apply to Word 2003 as well; all
apply to Word 2007 and 2010.
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This month the focus will be on the
types of graphics that may be inserted within
a Word document and how to insert them
successfully. To do this, we need to explore
the Illlustrations group within the Insert tab
in Word 2007.

Inserting Pictures

Since a picture is worth a thousand
words, often adding a photo to a document
helps clarify its meaning. To do this, open a
Word document and place the cursor on the
page where you want a photo to appear.
Double-clicking in any blank space inside the
margins will position the cursor at that spot.
Click the Insert tab - Picture. Your Pictures
folder will open, allowing you to select a
photo from your collection. Click the photo,
then click Insert to make the photo appear in
your document.

Depending on its size, the photo may
fill the screen, blocking out the text, or jump
to the next page. Instead of panicking, find
one of the corners of the photo and drag it
toward the center to reduce its size while
maintaining its proportions. When the photo
reaches the desired size, right click it and
select Text-wrapping - Tight or Square from
the menu.

This will allow the photo to be moved
around and positioned within the document
with text surrounding it. You can experiment
with other text-wrapping choices if you want
the photo positioned differently, such as
behind the text. Sometimes Text-wrapping is
not visible in this menu. Choose Format
Picture instead, then Layout, to get the text-
wrapping choices.

When you select the photo now, you
will notice that a new tab called Format has
appeared in the ribbon at the top of the
screen with the phrase Picture Tools above it.
Click Picture Tools to reveal commands
related to editing and formatting the photo.
These tools allow you brighten or crop the
photo, add borders and effects, and change
its position or size. When you deselect the
photo, notice that the Format tab and Picture
Tools disappear.

Inserting Clip Art

Office 2007 has extended the
definition of Clip Art to include not only the
standard drawings and photos, but also
movies and sounds. There are thousands of
these items which can be inserted into your
documents. Open your document and click
the Insert tab - Clip Art. Fortunately, the Clip
Art dialog box, which opens along the right
side of the screen, contains a powerful
search feature.

Begin by entering a search term, like
"birthday cake." Then, using the drop down
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menus, choose whether to search just on
your computer, the Microsoft Office website,
the whole web or all of these (best choice).
Y ou can also choose which kind of mediayou
want to search, such as clip art or sounds
only. With a fast Internet connection, it takes
only a couple of seconds for the Clip Art
search box to return items which meet your
search criteria after you start your search.

To add a clip art item to your
document, merely drag it from the Clip Art
box to your document. To add more than one
item at a time, hold down the Ctrl key while
you select items, and then drag the whole
group together. Once the clips are in the
document, follow the same general
instructions for resizing, text wrapping, and
moving as you did for photos. A Help
command at the bottom of the Clip Art box
can help you solve any problems you
encounter. You may close the clip art dialog
box when finished adding clips.

Inserting Shapes

Older versions of Word had a Drawing
toolbar which gave access to a few shapes
and tools for working with them. Word 2007
has made a noticeable improvement in the
number of available shapes and how shapes
are organized. On the Insert tab, click
Shapes in the Illustrations group to open the
expanded gallery.

Click the shape you want, but don't
expect it to appear instantly in your
document the way a photo does. Instead, you
must click inside the document where you
want the shape to appear. Hold down the left
mouse button and drag any direction to
make the shape visible. Onceit's there, it can
be resized by dragging one of the "handles"
(small squares along the edge) and moved the
same way as clip art. Right-clicking the
shape gives you a menu of options similar to
those for a photo or clip art.

If you select the shape in your
document, the Format tab appears again but
with new commands. Click Drawing Tools to
see ways to enhance your object. For
example, you can choose fill colours, effects,
and arrangements of multiple objects.

If you are designing a complex
arrangement of shapes, you may wish to use
the Drawing Canvas tool which is found at
the bottom of the shapes gallery. This tool
creates a large area in which to put multiple
graphic elements to create a complex
drawing. The canvas keeps objects from
moving around unexpectedly, but can be
difficult to control.

A simpler way to work with multiple
objects is to use the tools found in the
Arrangements group in Drawing Tools. One
command lets you move an object to the
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front or back of the arrangement; another
lets you rotate an object. An especially useful
command is Group, which is a simple way to
put objects together. First arrange the
objects in your document. Then, while
holding down the Ctrl key, select all the
shapes you need. Click Drawing Tools -
Group - Group to merge them so they are
treated like one object. If you want to split
them apart, click Group - Ungroup.

These three types of graphic items --
pictures, clip art, and shapes -- were part of
earlier versions of Word. They were improved
in Word 2007 by offering more choices and
better organization of tools. Next month we
will continue with a look at a new graphic

feature introduced in Word 2007 called
Smart Art, plus the improved Charts
element, and some ways that text can
become art as well.
One-Liners!!

Going to church doesn't make you a
Christian any more than standing in a
garage makes you a car.

We never really grow up, we only learn how
to act in public.

Bluetooth - Not a dental diagnosis or a
rare tooth problem.

By Phil Sorrentino, President, Sarasota PCUG,
Florida

president (at) spcug.org

October 2011 issue, Sarasota PC Monitor

Bluetooth is the name given to a
technology that uses short-range radio links,
and is intended to replace the cable(s)
connecting portable and/ or fixed electronic
devices. The vision is that it will allow for the
replacement of the many propriety cables
that connect one device to another with one
universal radio link.

Its boasts such key features as
robustness, low complexity, low power and
low cost, and it was designed to be operated
in noisy frequency environments.

Bluetooth is a communications
standard for interconnecting electronic
devices and is defined by the Bluetooth
specification. Bluetooth uses a form of data
packet switching, a technology that is used
to transmit digital data via a wireless
communications link.

Bluetooth operates in the unlicensed
ISM (Industrial, Scientific and Medical)
2.4GHz frequency band, and avoids
interference from other signals by hopping to
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a new frequency after transmitting or
receiving each packet. Hereisalittle history,
for you tech history buffs, to show how long
Bluetooth has been around.

Work on Bluetooth was started in
1994 by two Ericsson Corporation engineers,
and the Bluetooth 1.0 specification was
released May 1998. Version 1.0, with a data
rate less than 1 Mb/s, had many problems,
and manufacturers had difficulty making
their products interoperable. Bluetooth 2.0
was released November 2004 with a faster
data transfer rate (approx. 2.1Mb/s). And
finally, Bluetooth 3.0 was released April 2009
with a date rate of up to 24Mb/s with
improvements and new features and is the
current standard.

Bluetooth uses a radio technology
called frequency-hopping spread spectrum
which chops up the data being sent and
transmits chunks of it on up to 79 different
frequencies. Bluetooth provides a way to
connect and exchange information between
devices such as Smartphones, laptops,
personal computers, printers, Global
Positioning System (GPS) receivers, digital
cameras, video games, and others.

Bluetooth is an open, wireless
protocol for exchanging data over short
distances between devices, creating a
personal area network (PAN). It was
originally conceived as a wireless alternative
to the old serial RS-232 data cables.
Bluetooth is a network and thus can connect
many devices, unlike RS-232 which was
strictly serial point-to-point. Bluetooth is
primarily designed for low power
consumption, with a short range.

Three ranges are defined in the
standard, 100 meters (Class 1), 10 meters
(Class 2), and 1 meter (Class 3). Because
Bluetooth devices use radio (broadcast)
communications, they do not have to be in
line of sight of each other. Bluetooth makes
it possible for these devices to communicate
with each other and transfer information as
long as they are in range.

Both Bluetooth and Wi-Fi are
examples of wireless technology that use the

unlicensed 2.4GHz frequency spectrum.
Both have many applications in today's
offices and homes such as: setting up

networks, printing, connecting cooperating
devices, and transferring data files among
computers and smart devices. Wi-Fi is
intended as a replacement for cabling for
general local area network access in work
areas.

Bluetooth is intended as a
replacement for cabling among equipment in
close proximity. Wi-Fi is intended for use in
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equipment as a wireless local area network
(WLAN). Bluetooth is intended for use as a
smaller, personal area network (PAN).

A PC uses a Bluetooth adapter in
order to communicate with other Bluetooth
devices. While some desktop computers and
most recent laptops come with a built-in
Bluetooth adapter, others require an external
adapter, usually in the form of a Bluetooth
Dongle. Bluetooth allows multiple devices to
communicate with a computer over a single
adapter.

For Microsoft Windows platforms,
Windows XP Service Pack 2, Vista, and
Windows 7 all have native support for
Bluetooth. (Previous versions required users
to install their Bluetooth adapter's own
drivers, which were not directly supported by
Microsoft.)

Some of the more common applications of
Bluetooth are:

* Wireless control of and communications
between a mobile phone and a hands-free
headset. This was one of the earliest
applications.

* Wireless communications with PC input
and Output devices, the most common being
the mouse, keyboard and printer.

* Replacement of traditional wired serial
communications used in: test equipment,
GPS receivers, Medical equipment, bar code
scanners, and traffic control devices.

* Between game consoles such as Nintendo’s
Wii, and Sony’s Playstation and their
respective controllers.

* Between video camera and remote monitor
in Baby Monitor Systems.

* Between Garage Door Opener Motor and
Remote Garage Door Opener Controller.

As you can see from this list, there
are many reasons for computer devices to
communicate with each other. Here is a
quick computer communications concept
tutorial.  When any two devices need to
communicate, they have to agree on a
number of things before the communication
can begin.

The first point of agreement is
physical: Will they talk over wires, or through
some form of wireless signals? If they use
wires, how many are required; one, two,
eight, 25? Once the physical attributes are
decided, additional questions arise, such as
how much data will be sent at a time? For
instance, serial ports send data 1 bit at a
time, while parallel ports send several bits at
once. And, how will they speak to each
other? All of the devices in an electronic
network need to know what the bits mean
and whether the message they receive is the



same message that was sent (i.e. checksums
at the end of a message).

This means developing a set of
commands and responses commonly known
as a Protocol. Bluetooth is essentially a
networking standard that defines these two
levels, physical and protocol. Bluetooth
protocols simplify the discovery and setup of
services between devices.

Before any communications can take
place between two Bluetooth devices, they
have to be paired. In order to pair two
Bluetooth wireless devices, a password (or
PassKey) has to be exchanged between the
two devices. A Passkey is a code shared by
both Bluetooth devices, which proves that
both users have agreed to pair with each
other.

A very brief description of Bluetooth
pairing is as follows: Bluetooth Device A
looks for other Bluetooth devices in the area.
Bluetooth Device A finds Bluetooth Device B.
Bluetooth Device A prompts you, the user, to
enter a password (or PassKey). Bluetooth
Device A sends the Passkey to Bluetooth
Device B. Bluetooth Device B sends the
Passkey back to Bluetooth Device A. At this
point, Bluetooth Devices A and B are paired
and able to exchange data.

Data between the devices will be
accomplished wirelessly, over-the-air, a great
boon to those who dislike the “rats nest” of
wires typically found behind electronic
devices.

So, although dentists probably cringe
when they hear the term, with all the
computer devices you may have or are
thinking of getting, there’s probably a
Bluetooth in your future.

Tech Terms
By Sandy Berger, CompuKISS Newsletter

sandy (at) compukiss.com

If you want to be knowledgeable in
today’s world, you have to understand some
high tech terms. Here are few of popular
terms for 2011.

Terabyte

For the last few years, we have talked
about the amount of storage that a computer
has in terms of gigabytes. Now we are
starting to see computers offering terabyte
drives. A terabyte is 1,024 gigabytes. Or to
test your mathematical abilities, it is
equivalent to 2 to the 40th power or
1,099,511,627,776 bytes. You don't need to
know the details, just know that a terabyte
hard drive can store thousands and
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thousands of documents, songs, and other
data.

SSD

SSD stands for Solid State Disk. This
is a storage device like a hard drive. Unlike a
hard drive, however, it contains no moving
parts. SSDs are much faster than hard
drives and so they improve the performance
of acomputer or other device.

Cloud-Computing

In terms like "cloud computing,”
"cloud storage,” and "cloud services," the
cloud simply means the Internet. In cloud
computing, applications that run on the
Internet replace desktop programs that are
usually stored and run locally on your own
computer. When working "in the cloud," your
computer or your mobile device is simply the
conduit that connects with your data and
with a program that accesses your data.

Bing

Bing is a search engine that was
developed and is run by Microsoft. It is a
Google search engine competitor and
performs a very similar function. Note the
name. This may well be the first decent name
that Microsoft has chosen since it put out
Microsoft Office and Microsoft Word. You can
check out Bing's search capabilities by going

Video Streaming

Streeaming is a technique for
transferring data so that it can be processed
as a steady and continuous stream. It is
commonly used for video and movies. With
streaming, the device you are using to view
the videos can start displaying the video
before the entire file has been transmitted.
That means that you get to enjoy the video or
movie more quickly. Today's streaming
techniques also play movies more smoothly
than previous technologies.

Land Line

A land line is an old-fashioned
telephone line that gets service from a
telephone company and allows you to talk via
telephones that are attached to the wall.
People are giving up their land linesin droves
to take advantage of cell phones and Internet
telephone services.

FarmVille

FarmVille is a Facebook game by
Zynga. Millions of people play FarmVille.
They raise flowers and crops, feed the
animals, and organize and decorate their
farms. It is a truly incredible game and
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judging by the numbers of players, it is also
quite addictive. Ask around. If any of your
friends are playing this game, have them
show you their farms. | guarantee that you
will be amazed.

Netflix
Netflix
service for

is the leading subscription
renting DVDs and streaming
movies and television episodes over the
Internet. It currently has more than 20
million members who pay $8.95 or more a
month for this service.

Tablets

If you haven't heard of a Tablet or a
Tablet PC, you have been living under arock.
Tablets are a very easy way to work with
email and to browse the Internet. Tablets
have touch screens and run small Apps that
perform tasks like playing games, getting the
weather, sports scores, and other
information. Currently Apple's iPad is the
most popular tablet, but competitors are
starting to appear. Blackberry has a tablet
called the Playbook. Motorola has the Xoom.
Samsung has one caked the Tab. HP recently
introduced atablet called the TouchPad.

Now that you are up-to-date on some
of the technologies out there, it won't be long
before you buy atablet to view your Netflix
movies and buy a computer with a terabyte
hard disk to tend to your FarmVille farm
while doing most of your computing in the
cloud. Technology is moving fast. Jump
aboard and join the fun!

My iPad
By Terry Currier, President of the WINNERS
WINdows usERS group, CA

winner sug@aol.com
June 2011 issue, Winners Notepad

Yes, | brought an iPad. But there is a
reason or rational behind it. While at CES |
won an Apple iPhone 4. As it turned out
though they sent me an Apple Store card
worth $199 which would purchase the
iPhone 4, but was good for anything. | did
think about selling it, but | started to see the
iPad as something the grandkids could use
to play educational programs.

Thisiskind of like when my son some
years back bought us a good set of speakers
for $200 for our TV. My wife went out and
brought a $450 hutch to hold them. Not
quite equalling out. So I’'m getting $199 off,
but still have to spend about $350 to get the
iPad.
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After hearing about the iPad 2 coming
out | was really interested. Like many others
| was disappointed to see it did not come out
with the predicted USB port or media reader.
Some were even saying wait for the iPad 3,
but | decided to go ahead and get the iPad 2.

There was a four week wait for it at
the Apple Online store so | put the order in
and got $199 taken off. After it arrived | had
to set up an iTunes account. My first
impression was -- looks cool, but not really
ergonomic. The top is very smooth like glass.
At least in my personal opinion | would like
something like a rubberized strip. | want
something to stop it from slipping out of my
hands. This is especially true when the
grandson starts playing with it. | did buy a
case to hold it.

So far I've installed a number of
educational apps (programs) and a few
games. | have bought about $50 worth of
apps. I'm also trying many of the free
educational apps. They are lite versions; that
is, they show you a small portion of what it
will look like to get you to buy the full
version. My grandson is four so most of them
are ones that help kids learn the alphabet, or
how to count.

The one game that is addicting to all
of usis Angry Birds. Even my non-computing
wifelikes playing it. With my grandson | have
to set a limit with him so he also plays the
educational games.

One | thought would be really cool is
the Time Warner app. If you have them as a
TV and Internet provider you can download
the app for free. With it you can watch a
number of their channels on the iPad. Only
problem is Wi-Fi connection is poor for the
iPad. | can be sitting in my living room and
not get a connection and it is especially
evident with the Time Warner app. | can
catch the Wi-Fi signal very easily with my
notebook. | have sat right in front of the
router and it still has to buffer the video to
theiPad or it simply loses it.

While fun | do still consider it to be a
luxury item, but grandparents have been
know to spend lots of money on their
grandkids.

One liners!!!!

Evening news is where they begin with 'Good
evening', and then proceed to tell you why it
isn't.

The early bird might get the worm, but the
second mouse gets the cheese.
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